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Chapter-1 

Installation process of the software’s 

And Data Downloading 

Duration: 30 Minutes 
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System/Hardware Requirements 

 

 Minimum Recommended 

Processor-CPU Corei32.7Ghz Corei73.5Ghz 

Memory RAM 2Gb 8Gb or more 

Hard Disk 500 Gb SATA SSD de128Gb or 500 Gb SATA 

Graphic card 1GbRAM 2Gb RAM (NVIDIA Geforce) 

Operating System Windows 10 

Mac/Linux(Various)

Android 

Windows 10 

Mac/Linux (Various)Android 

 

(1) Download QGIS software 3.16.5 version from below link 

 

https://qgis.org/en/site/forusers/download.html 

https://www.download.qgis.org/ 

 

 

(2) Download Topo sheet (scale 1:50000) from Survey of India Website 

https://onlinemaps.surveyofindia.gov.in/FreeMapSpecification.aspx  

Open Survey of India Website, then Map services, online maps portal section. Identify 

your Toposheet number of areas using following Index Map and shapefile.  

http://www.download.qgis/
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(3) Open Geological Survey of India website from below link. 

http://www.gsi.gov.in 

 

(4) Download block boundaries of Indian States from below link. 

https://www.diva-gis.org/gdata 

 

(5) Download lineament map from below link. 

http://www.mpphed.gov.in/hgm.html 

 

(6) For downloading SRTM elevation data: Create UserID & Password with 

EarthData website from below link. 

https://urs.earthdata.nasa.gov/users/new 

 

 
 

 

 

http://www.gsi.gov.in/
https://www.diva-gis.org/gdata
http://www.mpphed.gov.in/hgm.html
https://urs.earthdata.nasa.gov/users/new


                                                                       

5 

 

 

 

 

 

 

 

 

1. Introduction of QGIS (Quantum GIS) 

 

Quantum GIS (QGIS) is an open-source Geographic Information System is available via 

Internet. The initial objective of the project was to provide a GIS data viewer. QGIS has 

reached a point in its evolution where it is being used by many, both individuals and 

corporations to meet their daily needs for viewing, analysis and management of GIS data. QGIS 

provides a growing range of skills through basic and complementary roles. You can view, 

manage, edit, analyze data and design maps which can be printed indifferent formats. 

 

1.1 Installation of QGIS 

Step1. To install the software QGIS must choose the web browser of your choice on your 

computer (for demonstration we are using Google Chrome) and select the installer, note that 

this software is free and open source. The web address where the installer is as 

follows:www.qgis.org , after selecting the executable file downloaded the application. Check 

the system configuration before downloading the .exe file (32 bit or 64 bit).

http://www.qgis.org/
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Step2.After the download proceed with terminal select the installer (.exe) and follow step by 

step installation the instructions below. Double click on " QGIS-OSGeo4W-3.16.0-Setup-

x86_64.exe. This is the welcome interface software that appears when you start the installation, 

in this step click on "Next". 

 

 

Welcome message window 

 

Step3.The following illustration shows the license information and the terms, if we agree 

click "I Agree". 
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Step4.The following illustration shows their commended destination which can be changed  

to our preference, we just press the button "Next". 
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Note: we must note that the program requires a minimum of 1.5GB of hard disk space to be 

installed, otherwise it cannot be made the installation disk. 

Step5.The following illustration shows and asked to select the components, usually just 

leave it and press the button "Install". 

 

 

 

Step6.The following illustration shows the process of installing the software, just wait. 

 

Step7.After the installation process is finished, click the button "Finish" and the software 

will be installed in your computer and can be proceeded to initiate work.  
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Step8.Go to start tool of your bottom left windows tool select QGIS3.16.5 installed folder 

and select QGIS Desktop3.16.5 with GRASS7.4.2 as shown below. 

 

Step9.QGIS3.16.5 desktop application opens as shown below 
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Chapter 2 

Introduction to QGIS 

Duration: 15 Minutes 
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2.1 What is Geographic Information System (GIS)? 

• A GIS is a system of computer hardware, computer software and geographical data. 

• A GIS Application allows you to view geographical data and is an important part of the 

GIS. 

• A GIS Application normally consists of a menu bar, toolbars, a map view and a legend. 

• Vector and Raster data are geographical data used in a GIS application. 

• Geographical data can have associated non-geographical data. 

• GIS Applications or Software's are normally programs with a graphical user interface that 

can be manipulated using the mouse and keyboard. 

    2.2 What is QGIS (Quantum GIS)? 

• QGIS is an open-source Geographic information system software which you can use for 

free.  

• It’s an Open-Source Application which provides Functionality and plugins to View, 

Edit, Store and analyze geospatial data. 

• With the help of Quantum GIS (QGIS), users can create Awesome Maps.  

• It’s available to Windows, MAC, Linux, BSD and as well for Android for free. 

 

2.2.1 What is Open source? 

1. It’s free. 

2. Frequent update 

3. Participate in development 

4. Multi-platform 

5. QGIS is a free and open-source cross-platform desktop geographic information system 

application that supports viewing, editing, and analysis of geospatial data.  

6. QGIS functions as Geographic Information System (GIS) software, allowing users to 

analyze and edit spatial information, in addition to composing and exporting graphical 

maps. 

7. QGIS supports both raster and vector layers. 

8. Vector data is stored as either point, line, or polygon features.  

9. Multiple formats of raster images are supported, and the software can georeferenced 

images. 

10. QGIS supports shapefiles, coverages, personal geodatabases, MapInfo, PostGIS, and  

other formats. Web services, WMS (Web Map Services) and (Web Feature Service), are 

also supported to allow use of data from external sources. 
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11. QGIS integrates with other open-source GIS packages. 

 

2.2.2 QGIS is Useful for 

1. For Developers - adapt or extend libraries and programs already written, to meet your 

own needs  

2. For Users – reduce acquisition costs – make your own customizations – enjoy a 

completely different support and maintenance model  

     3. For Students – learn from the code already out there, don’t reinvent the wheel 

 

Open Start Menu click on QGIS DEKSTOP 

Basics of QGIS (Quantum GIS) 
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QGIS Main frame view 

 

 

Main work Space area of QGIS 

  

Main Work Space 
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Chapter 3 

Downloading data: Toposheet, Ground 

Water Prospect, Elevation data, Geology 

and Geomorphology data 

Duration: 1 hr 15 Minutes 
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3.1 What is a Topographic Map? 

A topographic map is a detailed and accurate illustration of man-made and natural features on the 

ground such as roads, railways, power transmission lines, contours, elevations, rivers, lakes and 

geographical names. The topographic map is a two-dimensional representation of the Earth’s 

three-dimensional landscape. Available toposheet on scale of 1:50000 (2 cm=1000m.  (1 km)) 
 

3.1.1 What information is on a topographic map? 

Topographic maps identify numerous ground features, which can be grouped into the following 

categories:  

Relief: mountains, valleys, slopes, depressions as defined by contours  

Hydrography: lakes, rivers, streams, swamps, rapids, falls  

Vegetation: wooded areas  

Transportation: roads, trails, railways, bridges, airports/airfield, seaplane anchorages  

Culture: buildings, urban development, power transmission line, pipelines, towers  

Boundaries: international, provincial/territorial, administrative, recreational, geographical 

Toponymy: place names, water feature names, landform names, boundary names  

 

Refer to the map legend for a complete listing of all features and their corresponding symbols.  

Information along the map borders provides valuable details to help you understand and use a 

topographic map. For example, here you will find the map scale and other important information 

about the map such as the year, the edition and information pertaining to the map data. 

Topographic maps show contours, elevation, forest cover, marsh, pipelines, power transmission 

lines, buildings and various types of boundary lines such as international, provincial and 

administrative, and many others. Topographic maps show a universal transverse Mercator (UTM) 

grid, allowing the user to determine precise positions. In basic terms, topographic maps allow the 

user to see a three-dimensional landscape on a two-dimensional surface. 

 

3.1.2 What do the colours mean?  

A variety of colours can be found on a map, each relating to different types of features. Black 

shows cultural features such as buildings, railways and power transmission lines. It is also used 

to show geographical names (toponymy), certain symbols, geographic coordinates and precise 

elevations. Blue represents water features, such as lakes, rivers, falls, rapids, swamps and 

marshes. The names of water bodies and water courses are also shown in blue, as are magnetic 

declination and UTM grid information. Green indicates vegetation such as wooded areas,  
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orchards and vineyards. Some northern areas of Canada are mapped in black and white 

(monochrome). What are contour lines? Contour lines connect a series of points of equal elevation 

and are used to illustrate relief on a map. They show the height of ground above mean sea level 

(MSL) either in meters or feet, and can be drawn at any desired interval. For example, numerous 

contour lines that are close to one another indicate hilly or mountainous terrain; when further 

apart they indicate a gentler slope; and when far apart they indicate flat terrain. 

 

 

 

3.1.3 What is scale?  

Maps are made to scale. In each case, the scale represents the ratio of a distance on the map to 

the actual distance on the ground. A standard Canadian topographic map is produced at 1:50 000, 

where 2 cm on the map represents 1 km on the ground.  

 

𝑀𝐴𝑃 𝐷𝐼𝑆𝑇𝐴𝑁𝐶𝐸

𝐺𝑅𝑂𝑈𝑁𝐷 𝐷𝐼𝑆𝑇𝐴𝑁𝐶𝐸 
  =  

2 𝑐𝑚

1 𝑘𝑚
 =   

2 𝑐𝑚

100 000 𝑐𝑚
 =   

1

50 000
 

 

SCALE               1:50 000 

 

Medium-scale maps (e.g. 1:50 000) cover smaller areas in greater detail, whereas small-scale 

maps (e.g. 1:250 000) cover large areas in less detail. A 1:250 000 scale national topographic 

system (NTS) map covers the same area as sixteen 1:50 000 scale NTS maps. 

 

 



                                                                       

17 

 

 

3.1.4 What is a grid?  

A grid is a regular pattern of parallel lines intersecting at right angles and forming squares; it is 

used to identify precise positions. To help you locate your position accurately on the surface of 

the Earth (or map sheet), topographic maps have two kinds of referencing systems: • universal 

transverse Mercator (UTM) projection (easting/northing) • geographic: degrees and minutes 

(longitude/latitude) The projection used for topographic maps is UTM. The UTM grid is a square 

grid system of lines depicted on maps and based on the transverse Mercator projection. It can be 

used to accurately locate the position of features on the map by distance or direction. 

 

 

Index for conversion of Topo Sheet No. to OSK sheet No. 
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3.2 Download the Toposheet of Study Area 

• Download Topo sheet (scale 1:50000) from Survey of India Website 

(https://onlinemaps.surveyofindia.gov.in/FreeMapSpecification.aspx).  

• Open Survey of India Website, then Map services, online maps portal section 

• How to Identify the required toposheet number of study area? 
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3.2.1 Study of toposheet and Base Map Preparation 

(a) Demarcation of study area in block boundary 

(b) Identification of catchment/ Watershed 

• Digitize drainage from ridge to valley 

• Demarcation of Watershed area 

• Development of various order of drainage and its intercept at slope of the area 

• Location of village/Road/Waterbodies 

• Triangulation Elevation in Survey of India Toposheet 

( c ) Study of 20 meter contour elevation of Topo sheet in its variation for landscapes 

 

identification of high ridges, valley slope, intercept at drainage order 

(d) Identification of the Forest boundary (Green color) 
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3.3 Downloading Geology Map 

Hands on Training - Generation of Geology and Geomorphology of the study area. 

Step 1: Open Geological Survey of India website 

 

 

✓ Download Block Boundaries 

▪ Download block boundaries of Indian States from below link  

▪ https://www.diva-gis.org/gdata 
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✓ Check the state and Block boundary 

 

 
Step 2: Open Geological Survey of India Website, Maps, and then Map series. In this series you 

can search your data with State name and DRM data. This data will download in ZIP file. The 

zip file extract in the specified location. These files are in PDF format, we have to convert these 

files into JPG format for further use or extracting data. 
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3.4 Downloading Lineament Map 

Download Lineament Map from 

 
• link to Download map:  

• http://www.mpphed.gov.in/hgm.html 

http://www.mpphed.gov.in/hgm.html
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 Steps:  

✓ Just click on the district for download lineament Map. 

✓ The District.rar will downloaded by the user. 

✓ Extract that file and many pdf files will open. 

These pdf file names are divided on the basis of Toposheet number of the area. Convert these 

pdf files into JPG format for georeferencing by ilovepdf online converter. 
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Chapter 4 

Hands on Training- Process of 

Georeferencing 

Duration: 1 hr 45 minutes 
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4.1 Geo-Referencing in QGIS 

• Georeferencing is a process of establish a mathematical relationship between the image 

coordinate system and the world spatial coordinate system. 

Step 1: First, open Quantum GIS (QGIS) software  

• Start All programs QGIS-Desktop QGIS  

Step 2: Open QGIS Georeferencer (Raster      Georeferencer       Georeferencer). 

 

Step 3: The Georeferencer is in the form of a window with two parts to it. 

• The upper part is called as ‘main Work Space’ dedicated to display the Raster Map to be 

georeferenced and it allows the user to input the geographic or projected coordinates of 

control points. 

• The lower part, titled ‘GCP table’, is where the Ground Control Point data and residuals 

will be displayed. 
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Setp 4: Add the toposheet to the Georeferencer by clicking on the Open Raster button or 

from the File menu (File        Open Raster). 

Step 5: Click on the drop-down menu right to the ‘File name’ and select ‘[GeoTIFF]’. 

Now select the ‘toposheet.tif’ and click ‘Open’. 

 

 

Check the coordinates. This is not georeferenced so it will not give any real coordinate 

information. 
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Step 6: You will then be presented with the ‘Coordinate Reference System Selector’ window 

from which we will select the ‘WGS 84’ under Coordinate reference system of the world 

section. 
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Step 7: The toposheet will be loaded in the Georeferencer window. 
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Step 8: To georeferenced an image we use Ground control points (GCPs). GCP is a location 

on the earth’s surface with known coordinates on both earth and Toposheet/imagery, i.e. 

geographic and pixel coordinates respectively. 

Step 9: To start adding GCPs to our map, we first zoom to a corner of the map where we can 

easily identify the intersection of the latitude and longitude.  

Step 10. To add a GCP click on the ‘Add point’ button, or go via menu (Edit-Add Point). 

The mouse will transform into a ‘+’ sign, which we use to click on the center of the 

intersection. Use ‘view tool’ when needed. 

 

 

Step 11: A window ‘Enter map coordinates’ will pop up where we enter the coordinates of 

the point which we take from the map. 

Always enter ‘Longitude or Easting’ in X field and ‘Latitude or Northing; in Y field. Use same 

procedure for marking six more points. 
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Step 12: We now set the spatial reference settings for the toposheet by clicking on the 

‘Transformation Settings’ button. 

The ‘Transformation Settings’ window pops up in which we will enter the spatial information 

of our map. 

Step 13: Click on the ‘Transformation type’ drop-down menu and select ‘Polynomial 2’. This 

means we will be using a second order polynomial transformation. 

Step 14: Click on the button next to ‘output Raster’. A dialogue box will appear in which we 

enter the name of our output file. It is recommended to include the name of the original file. 

 

 

 

Step 15: ‘Check’ the check box ‘Load in QGIS when done’ and ‘Use 0 for transparency when needed’, 

leave the reset of the values as default and click ‘OK’. 

Step 16: After Click ‘OK’ the last column ‘residual [Pixels]’ displays some values. These are the error 

values associated with the GCPs. An error value of 1 or less would be satisfactory. 
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Step 18: Double check and adjust the GCP locations if the value is greater than 1. To adjust a 

point, click on the ‘Move GCP point’ button, and then click and drag the point to the desired 

location.  

Use ‘Delete Point’ button to delete an erroneous GCP. We can also enable and disable the 

GCPs by using check boxes under ‘on/off ‘column in ‘GCP Table’. 

Step 19: Once the error is around or below 1, click the ‘Start Georeferencing’ Button. 

The processing will take at about 2 minutes. 

The georeferenced image will be found at the location specified for the ‘Output File’. The 

output file will have loaded in the canvas also. 

Output georeferenced Toposheet 
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Chapter 5 

Hands on Training- Process of Generating 

Vector Layers in QGIS 

Duration: 1 hr 30 Minutes 
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5.1 PROCESS OF EXTRACTING DATA 

MAP CREATION (MAPPING QGIS) 

Digitization 

• Digitization refers to creating a digital representation of physical objects or attributes.  

• QGIS has powerful on-screen digitizing and editing capabilities that we will explore. Go 

to. 

 

 

 

 

 

Add Georeferenced Toposheet 

 

 

LAYER ADD LAYER
ADD RATSER 

LAYER
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Before we start, we need to set default Digitizing Options. Go to Settings ‣ Options.... 

 

 

• Select the Digitizing tab in the Options dialog.  

• Set the Default snap mode to vertex and segment.  

• This will allow you to snap to the nearest vertex or line segment. Prefer to set the Default 

snapping tolerance and Search radius for vertex edits in pixels instead of map units.  

• This will ensure that the snapping distance remains constant regardless of zoom level.  

• Depending on your computer screen resolution, you may choose an appropriate value. 

Click OK. 
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Creating a New Shapefile Layer 

 

 

 

• Now we are ready to start digitizing. 

• We will first create a roads layer and digitize the roads around the park area. 

• Select Layer ‣ New ‣ New Shapefile Layer...   

• We are creating a couple of polygon layers and a line layer. 
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The new shapefile layer dialog box opens, then we select the type of geometry, and add to the 

attribute list, and then click on OK. 
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• Once the layer is loaded, click the Toggle Editing button to put the layer in editing mode. 
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• Click the Add feature button. Click on the map canvas to add a new vertex.  

• Add new vertices along the road feature. Once you have digitized a road segment, right-

click to end the feature. 

 

 

• After one right-click to end the feature, you will get a pop-up dialog called Attributes. 

• Here one can enter attributes of the newly created feature.  

• Since the ID is an auto-incrementing field.  

• Leave it blank and enter the road name as it appears on the topo map.  

• Optionally, assign a Road Class value as well. Click OK. 



                                                                       

42 

 

 

 

• The default style of the new line layer is a thin line. Let’s change it so we can better see 

the digitized features on the canvas.  

• Right click the Roads layer and select Properties. 

• Select the Style tab in the Layer Properties dialog.  

• Choose a thicker line style such as Primary from the predefined styles. Click OK. 

• Now you will see the digitized road feature clearly.  

• Click Save Layer Edits to commit the new feature to disk. 

• Before we digitize remaining roads, it is important to update some other settings that are 

important to create an error free layer.  

• Go to Settings ‣ Snapping Options... 

• In the Snapping Options dialog, check the Enable Topological Editing.  

• This option will ensure that the common boundaries are maintained correctly in polygon 

layers.  

• Also check the Enable snapping on intersection which allows you to snap on an 

intersection of a background layer. 
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• Now you can click Add feature button and digitize other roads around the park.  

• Make sure to click Save Edits after you add a new feature to save your work. 

• A useful tool to help you with digitizing is the Node Tool.  

• Click the Node Tool button. 

 

• Once the node tool is activated, click on any feature to show the vertices.  

• Click on any vertex to select it.  

• The vertex will change the colour once it is selected.  

• Now you can click and drag your mouse to move the vertex.  

• This is useful when you want to make adjustments after the feature is created.  

• You can also delete a selected vertex by clicking the Delete key.  

• Once you have finished digitizing all the roads, click the Toggle Editing button. 
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• Now we will create a polygon layer representing the park boundaries.  

• Go to Layer ‣ New ‣ New Shapefile Layer.... Select the nztopo.sqlite database from the 

dropdown list.  

• Name the new layer as Parks. Select Polygon as the Type. Create a new attribute 

called Name. Click OK. 
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• Click the Add feature button and click on the map canvas to add a polygon vertex.  

• Digitize the polygon representing the park. Make sure you snap to the roads vertices so 

there are no gaps between the park polygons and road lines.  

• Right-click to finish the polygon. 

• Enter the park name in the Attributes pop-up. 

 

 

• Polygon layers offer another very useful setting called Avoid intersections of new 

polygons.  

• Go to Settings ‣ Snapping Options.... Check the box in the Avoid Int column in the row 

for the Parks layer. Click OK. 

• Now click on Add feature to add a polygon. With the Avoid intersections of new 

polygons, you will be able quickly digitize a new polygon without worrying about 

snapping exactly to the neighboring polygons. 

 

• Right-click to finish the polygon and enter the attributes.  

• Magically the new polygon is shrunk and snapped exactly to the boundary of the 

neighboring polygons. 
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• This is very useful when digitizing complex boundaries where you need not be very 

precise and still have topologically correct polygon.  

• Click Toggle Editing to finish editing the layer. 

 

 

Creating Polygon 

• Now it is time to digitize a buildings layer.  

• Create a new polygon layer named Buildings by going to 

•  Layer ‣ New ‣ New Shapefile Layer. 

• Once the building layer is added, turn off the Parks and Roads layer so the base topo map 

is visible. 

• Select the Buildings layer and click Toggle Editing.  
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• Digitizing buildings can be a difficult task.  

• Also it is difficult to add vertices manually so that the edges are perpendicular and form 

a rectangle.  

• We will use a plugin called Rectangles Ovals Digitizing to help with this task.  

• Once the Rectangles Ovals Digitizing plugin is installed, you will see a new toolbar 

appear above the canvas. 
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• You will notice that some buildings are not vertical. We will need to draw a rectangle at 

an angle to match the building footprint. Click the Rectangle from center. 

 

 

 

• Zoom to an area with the buildings and click Rectangle by Extent button.  

• Click and drag the mouse to draw a perfect rectangle. Similarly, add remaining buildings. 
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• Click at the center of the building and drag the mouse to draw a vertical rectangle. 

 

 

• We need to rotate this rectangle to match the image on the topo map.  

• The rotate tool is available in the Advanced Digitizing toolbar.  

• Right-click on an empty area on the toolbar section and enable the Advanced 

Digitizing toolbar. 

• Click the Rotate Feature(s) button. 
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• Use the Select Single feature tool to select the polygon that you want to rotate.  

• Once the Rotate Feature(s) tool is activated, you will see crosshairs at the center of the 

polygon.  

• Click exactly on that crosshairs and drag the mouse while holding the left-click button.  

• A preview of the rotated feature will appear.  

• Let go of the mouse button when the polygon aligns with the building footprint. 

 

Point Layer Creation 

To create new point layer, go to main menu bar in QGIS interface and select ‘Layer’ ‘New’ 

‘New Shapefile Layer’. 

2. Now the ‘New vector Layer’ windows will popup. Select ‘Type’ as ‘Point’ as we are 

interested in creating a point layer. 

3. Specify CRS same as original layer, i.e., as ‘EPSG:4326 - WGS 84’. To do this click on 

‘Specify CRS’ Select the ‘WGS 84’ under Coordinate reference system of the world Click on 

‘OK’. 

4. We can add new required attribute fields to the vector layer that we have created.  

For example, if we are creating point vector layer of all hospitals we can add ‘Name’ of the 

hospital as new field and ‘intake capacity’, ‘Address’ etc. as other fields. 
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5. For Each New attribute added, an appropriate name, type of the variable (like text, whole 

number, decimal number and date) and width must be selected.  

6. Click on ‘Add to attribute List’ and the attribute will be added to the list. Now add the 

attributes details shown in the below figure. 
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7. Now you will be presented with ‘Save As’ window, save the file in appropriate drive with 

appropriate name for example: Hospitals_Pune.shp. Once the layer is saved it opens up as 

point data layer under map legend. 

8. To start digitization, we have to enable the editing mode of the corresponding vector layer. 

Right click on ‘Hospital_Pune.shp’ point layer and click on ‘Toggle Editing’ or select the layer 

and click on icon from ‘Digitizing’ toolbar. 

9. The point will be created with the specified attributes at the specified location. Now open 

the attribute table of ‘Hospital_Pune.shp’ by right clicking on the hospital layer and selecting 

‘Open Attribute Table’. 

 If you want to change any details, then simply select the attribute by double click and edit it. 

For example, change the intake capacity of Bharati Hospital from 1000 to 1200. 
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Chapter 6 

Hands on Training –Process of 

Digitization of Drainage and  

Duration: 1 hr.  
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6.1 Drainage 

• Drainage: 

➢ The flow of water through well-defined channels is known as ‘drainage’ and the 

network of such channels is called a ‘drainage system’. 

• Drainage Pattern: 

➢ It refers to the system of flow of surface water mainly through the forms of rivers 

and basins.  

➢ The drainage system depends upon factors such as slope of land, geological 

structure, amount of volume of water and velocity of water.  

 

Digitization of Drainage or Preparation of Drainage Map 

1. Add Georeferenced Topo-sheet Map on QGIS Main Panel. 

2. Click on Layer, Add layer and then Add Raster Layer  
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. After adding raster map create shapefile with linear feature type. 
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➢ Steps for creation of Shapefile  
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➢ Steps for Drainage Digitization  
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➢ Final Digitized Drainage Map  

 

 

 

➢ How to Categorize Different Orders of Drainages 

➢ Right click on layer and click on categorized drop down button. 

➢ Choose nay symbol layer type and the color symbology and line width or style 

of the layer then OK  
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➢ Categorize Drainage On the basis of Attribute or Order  
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➢ Classified Labelled Map of Drainage  

➢ Drainages are classified in low to highest  

➢ Order with color symbology.  
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➢ How to calculate Length of the Stream? 
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Note: Drainage length unit is meter by default or on the basis of Map units.  
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Chapter- 7 

Clipping Tool & KML Creation 

using QGIS 

Duration: 30 minutes 
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1. Clipping Tool in QGIS 

In this section we clip village boundary and proposed structure. 

 

 

 

In this, select desire village boundary. 

 

 

Search Clip Tool in toolbox window present in processing toolbox window. 
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1. Create KML in QGIS 

Open Google Earth Platform 

 

 

 

Open your saved shapefile 
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Final output of KML 

 

 

 

 

 

Glossary 

Topographic terminology  

 

 

Bearing: The horizontal angle at a given point, measured clockwise from magnetic north or true north to 

a second point.  

 

Classified roads: Roads for which surface type, width and use are identified. 

 

Unclassified roads: Roads for which the surface is unidentified. 

  

Contour lines: Lines on a map connecting points of equal elevation above mean sea level; using contour 

lines, relief features can be profiled into a three-dimensional perspective.  

 

Elevation: Vertical distance from a datum (usually mean sea level) to a point or object on the Earth’s 

surface.  
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Legend: A description, explanation table of symbols, or other information, on a map or chart to provide 

a better understanding and interpretation of it.  

 

Magnetic north: Direction to which a compass needle point.  

 

Mean sea level: The average height of the surface of the sea for all stages of tide, used as a reference 

surface from which elevations are measured.  

 

National Topographic System: An orderly index system suitable for a series of maps of different scales 

for the coverage of Canada.  

 

Projection: Geometric representation of the curved surface of the Earth on a flat sheet of paper.  

 

Relief: The physical configuration of the Earth’s surface, depicted on a topographic map by contour 

lines and spot heights.  

 

Spot elevation: A point on a map where height above mean sea level is noted, usually by a dot and 

elevation value; it is shown wherever practical (road intersections, summits, lakes, large flat areas and 

depressions).  

 

Symbols: A diagram, design, letter or abbreviations, placed on maps, that (by convention, usage or 

reference to a legend) is understood to stand for or represent a specific feature or object.  

 

Topography: Surface features both natural and man-made, collectively depicted on topographic maps.  
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